
Introduction

The PC software package (STSW-ST25R023) contains the ST25R300 evaluation board GUI and the ST25PC-NFC software 
(STSW-ST25PC001).
The ST25R300 evaluation board GUI allows the user to communicate with the ST25R300 evaluation board 
(STEVAL-25R300KA). It provides an interface to change a wide range of settings. It also allows different features of the 
STEVAL-25R300KA kit to be executed and evaluated. This user manual provides a detailed description of the ST25R300 
evaluation board GUI.
The ST25PC-NFC software (STSW-ST25PC001) gives access to all features of the ST25 NFC/RFID tags and ST25 dynamic 
NFC tags. It is not the object of this user manual.
The PC software must be used with the ST25R300 evaluation board, which contains all the necessary modules for a fully 
functional NFC reader.
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1 Preface

1.1 Downloading and installing the software
After downloading the software (available at st.com), double-click the executable file to begin the installation.
• Select whether to install the software for each user of the PC or only for the current user.

Figure 1. Selecting install mode

• Select the path to install the software.

Figure 2. Selecting the program destination
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• It is possible to add the ST25R300 evaluation GUI to the start menu. This is recommended to allow the 
user to always find the software easily using the Windows® search function. If the user does not want to 
add the software to the start menu, they just need to tick the checkbox in the bottom left corner of the 
window.

Figure 3. Selecting a start menu folder

• To create a shortcut on the desktop, tick the checkbox shown below.

Figure 4. Creating a desktop shortcut
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• The figure below shows a summary of the selected installation directories. Click install.

Figure 5. Ready to install

• Installing takes no more than a few minutes to complete. Launch the application by clicking the finish 
button.

Figure 6. Installation completed

Note: This software is only available for PCs running on Microsoft® Windows®.
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1.2 Hardware preparations
Communication with the board happens through the mini-USB J2 (STLINK-USB). On this port the STLINK 
provides a virtual COM port used for communication.
Using the on-board UI please select PCLink before connecting from PC GUI.

Figure 7. ST25R300 evaluation board - top view

The STEVAL-25R300KA kit is described in a separate user manual.
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2 Reader mode

The application offers two different GUI modes:
• ST25PC-NFC

It opens a new window which allows to access ST25 Tags and its specific features through the connected 
STEVAL-25R300 board.

• Reader mode
It allows the user to explore a wide range of functions in detail.

This section provides an overview of all the functions available in reader mode.

Figure 8. GUI modes

The brighter blue color indicates that reader mode is enabled. To change the mode, click on the appropriate icon.

2.1 Main tab
The Main tab contains the Board Info tab and the Overview tab.

2.1.1 Board info tab

Figure 9. Board info tab

The Board info tab allows the GUI to be connected to the ST25R300 evaluation board. To connect a board, 
ensure that the correct COM port and baud rate are selected.
When a board is connected, this tab displays basic information about the connected hardware.
• Firmware version

The firmware version currently running on the MCU.
• Demo board version

The type of demonstration board.
• STM32 UID

The unique ID of the STM32 on the STEVAL-M25B1 main board.
The Update firmware button allows the user to update the firmware running on the STM32G0 on the STEVAL-
M25B1 main board. See Updating the firmware for more information.
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2.1.2 Overview tab
The Overview tab is a quick demonstration showing a typical NFC application combining wake-up mode and 
NFC polling. As soon as wake-up mode detects a variation, standard NFC polling is performed and the cards/
devices found are listed.
The demonstration remains in polling mode until no more cards/devices are detected.

Figure 10. ST25R300 overview

A small window with settings opens after clicking on the Polling Configuration button.

Figure 11. Polling configuration

These settings allow the user to enable/disable polling for different technologies. It is also possible to enable 
polling only and not to perform a wake-up.
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To view the tab in full screen, click on the extended view icon.

Figure 12. Extended view

Click the same button again to exit full screen mode.

2.2 Features tab
This tab allows the user to discover the different features of the ST25R300 in the subtabs. Each subtab 
represents a feature and provides different settings for the corresponding functionality.

2.2.1 Power tab
The Power tab allows the user to set the ST25R300 to five different modes:
• Reset
• Power-down
• Wake-up
• Ready
• Ready + Field on
Each mode has a different power consumption (use the pins of L200 to measure the actual power consumption of 
the chip). The mode can be changed using the radio buttons on the left. The bar graph on the right side visualizes 
the different power consumption of the different modes. The currently selected mode is highlighted by a darker 
color in Figure 13.

Figure 13. Power consumption
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2.2.2 Antenna tab
The needle shows the amplitude as measured on RFI, and the phase difference between RFI and RFO 
(calculated back from I/Q channel values).
Additionally, other analog voltages and current can be measured.
Click on the measure antenna button to measure these values.
Activate VNA puts the output driver into high-Z state to be able to connect a VNA without damaging it. This blocks 
the GUI until the user has confirmed that VNA is removed.
Amplitude and phase difference can be continuously monitored using the continuous measurement button. 
Moreover, when this option is activated and a piece of metal is approached to the antenna, a detuning effect can 
be observed.

Figure 14. Antenna tab

2.2.3 Wake-up tab
The wake-up mode uses very low power to detect if an object has entered the reader field. The field is switched 
on for a short time to measure whether an object has entered the field. The measurement provides the I and Q 
channel values. For more information, see the ST25R300 datasheet (DS14655) and application note (AN6298).
Two graphs show the measured I and Q values. Click the Start button to start wake-up mode. The graphs in pink 
correspond to the measured values. The blue-colored graphs represent the upper and lower thresholds. The last 
measured I and Q ADC values are displayed above the two graphs.
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Figure 15. Wake-up tab with the configuration shown

By default, a wake-up is triggered when the pink line (measurement) crosses one of the blue lines (threshold). 
When a wake-up interrupt is triggered, the pink line is marked with a circle.

Click on the Show configuration button to display the wake-up mode settings. These settings are mainly those 
found in the ST25R300 datasheet (DS14655). To change the settings, stop wake-up mode if it is currently 
enabled.

Figure 16. Wake-up configuration shown

Click the Send To Overview button to apply the selected settings to the wake-up functionality provided by the 
Overview tab (refer to Overview tab).
The timer feature allows to monitor the I/Q values over a fixed time for post-processing (e.g. calculate standard 
deviation).

2.2.4 Analog config tab
This tab contains important configuration settings required to set chip-specific configurations for different 
technologies and bitrates at different operating times. The concept of analog configuration is part of the RFAL 
library and is used throughout the different ST25R devices. See the RFAL user manual (UM2890) for more 
details.
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Figure 17. ST25R300 Analog config tab

The Analog Config tab is divided into the Mode, Functions, Actions, and Hashes sections.

Mode

The Mode section provides a drop-down box containing several chip-specific supported technologies and events. 
A specific mode can be added to the mode list. This makes it easy to have individual settings for all transmit and 
receive modes. The CHIP_INIT mode sets global registers that must be used independently of other selected 
modes. For example, the pull-down of SPI lines can be enabled.

Functions

The Functions section contains register values associated with modes. A function consists of a name, the 
corresponding register, a mask, and the required value for the register. Frequently used functions can be selected 
from the drop-down box and added to the functions list. These functions are already defined and can be selected 
from a drop-down box.
For better readability, modes can be ordered using the up and down arrows in the mode section.

Attention: Be careful when defining the same registers or functions for multiple entries in the mode list: for example, if a 
function is added to ISO 14443A and not restored in ISO 14443B mode, it is also applied to ISO 14443B.

Actions

The Actions buttons complete the analog configuration concept. They read and write information to the board or 
to the PC.
The Read from board button reads the analog configuration from the connected board.

Note: The values currently displayed on the GUI are overwritten.
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The Write to board button writes the current configuration from the Analog Config tab to the connected board.

Note: If the Analog Config tab is left empty, the board remains with its stored values.

The Load from file button is used to load a previously saved configuration file into the Analog Config tab.
Use Write to board to write these newly loaded settings to the connected board.
The Save to file button saves the current configuration in the Analog Config tab to the file system.
The Generate custom code button can be used to automatically generate a C header file for direct inclusion in a 
compiled firmware image. See the RFAL user manual (UM2890) for further details.
The Store to Flash allows to send the settings into STM32 flash. It is used as new default on start-up.

Hashes

The Hashed section shows the analog configuration hashes currently loaded into the different areas. The FW 
active (RAM) field is the configuration currently in use. It can be different from the FW stored (Flash) field. The 
FW stored (Flash) field contains the hash value that is loaded when the chip is switched on. It is possible to load 
an analog configuration temporarily until the chip is switched off and on again. Click on Write to board without 
ticking the Store to flash checkbox to load a temporary configuration.

2.2.5 DPO CR
DPO CR is a software-based feature that allows dynamic control of the transmitter voltage (VDD_DR), driver 
resistance, and the generated RF field depending on the presence of a PICC. A dynamic RF power adjustment 
can be useful in challenging environments where strong antenna detuning causes an abrupt increase in driver 
current and a violation of the maximum allowed field strength in the applicable standard. The dynamic adjustment 
of output power uses the current measurement capabilities of the ST25R300.

Figure 18. DPO CR panel overview

The DPO function is enabled by clicking on the “Enable DPO” button.
The following section describes the DPO functionality and using the ST25R300.
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2.2.5.1 DPO CR details

The goals of DPO CR are:
1. reduce output power to ensure HMAX anywhere in the operating volume (especially in close distance)
2. increase output power to ensure HMIN anywhere in the operating volume (especially in far distance (4 cm)
3. Limit the power consumption in strong coupling conditions to avoid overloading the board’s and USB supply 

capabilities
It performs this task by changing the ST25R300 internal regulator (rege) to lower VDD_DR (the output driver 
supply voltage) and by adjusting the driver resistance (dres). The criterion for regulation is the chip internal 
measurement of the current flowing through the VDD_DR regulator. The algorithm tries to maintain the lowest 
dres if possible.
The inputs of the algorithm are:
• Target current with a threshold, when measured value is off by threshold the algorithm tries to again 

regulate
• rege min and max: Allowed voltage value range. Limits to be taken into account:

– Rege min needs to be above 3.3 V to have current measurement operational
– Rege max setting of VDD_DR should have at least 300mV drop to VDD_TX to have current 

measurement operational
• dres min and max: Allowed driver resistance setting range. Displayed value is factor for RRFO
• AWS levels can be used to apply different AWS settings depending on rege settings.
The following example illustrates the operation of DPO CR when started from unloaded condition, then a load 
(field detector) being placed and subsequently removed:

Figure 19. DPO CR operation

The arrows indicate:
1. Current slightly below target, system at maximum rege:107 and minimum dres:5. With approaching load the 

current increases
2. Current was too high and algorithm starts to decrease rege
3. Decreasing rege was not sufficient anymore, now also dres is getting increased.
4. Rege at minimum, dres at maximum, output power cannot be further decreased. With increasing load now 

also the current is increasing.
5. Load is getting removed, first dres gets decreased, then also rege gets increased
6. System settled back again to unloaded condition at max rege and min dres

2.2.5.2 DPO CR parameters
To use the dynamic power adjustment, the user has to choose parameters.
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Figure 20. DPO CR settings
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The parameters are:
• Target current which the algorithm tries to achieve by changing regulator and driver resistance settings.
• Hysteresis threshold to avoid oscillation. The default is 2.
• Power output is adjusted through regulator voltage (rege) and driver resistance (dres). Minimum rege is the 

lowest driver supply, resulting in lower output power.
• Power output is adjusted through regulator voltage (rege) and driver resistance (dres). Maximum rege is 

the highest driver supply, resulting in higher output power.
• Power output is adjusted through regulator voltage (rege) and driver resistance (dres). Minimum dres 

results in lowest driver resistance and highest output power.
• Power output is adjusted through regulator voltage (rege) and driver resistance (dres). Maximum dres 

results in highest driver resistance and lowest output power.
• AWS levels can be used to define waveshape settings depending on the regulated voltage chosen by the 

algorithm.
The behavior of DPO CR can be observed by pressing the Continuous measure button. Then, the ST25R300 
emits a continuous carrier with basic A/B polling, and displays the measured current, rege and dres values, and 
DPO status in the GUI.
The DPO CR area in the status bar at the bottom right displays the actual AWS level used by the algorithm. It is 
depicted by the background color (blue, green, yellow, or pink). The area is updated during continuous 
measurement, displaying the rege voltage and the dres value used by the regulation algorithm. The dres value is 
marked with an indicator showing when the limit set is reached: the character '_' denotes that the minimum dres 
value is reached, and the character '^' denotes that the maximum value is reached. Typically, DPO CR is used to 
reduce the generated field in close proximity to the reader.

2.2.5.3 Saving a DPO setting
The Load file button enables to restore DPO CR parameters from a file, tune them using the GUI until a 
satisfying configuration has been found, and save them thanks to the Save file button.

Figure 21. Load and Save DPO dataset
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The Read from board button enables reading the current configuration used by the firmware within the 
connected board. The Write to board button allows writing the configuration displayed by the GUI to the board into 
volatile memory (RAM). This means that these parameters are lost after the board is reset or removed from the 
PC. To write the configuration permanently in persistent memory, click on the checkbox Store to flash and press 
the Write to board button: the configuration is applied to the board and remains after reset or removal of the 
board.

2.2.5.4 AWS
AWS (active wave shaping) is a feature of the ST25R300. It lets the user control the shaping of the rising and 
falling edges of the modulated signal. Choosing the number of levels makes more GUI features available, which 
let the user additionally influence the wave-shaping feature of ST25R300 depending on regulator setting and used 
technology. The DPO tab lets the user control the static AWS configuration of the ST25R300 in a more flexible 
way:
• Adjust transients for the waveshapes with slow to fast preset values
• Fine-tune RF undershoot and overshoot patterns per power level and mode
• More granular adjustments of driver resistance
• Selection of modulation index used for each DPO level.
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The active wave shaping in ST25R300 is accomplished primarily by using the corresponding AWS registers.
Refer to the document for more details.
These parameters are stored and transferred to the analog configuration settings and are automatically parsed 
while switching to the DPO CR tab.
As a result, the user finds the following new modes controlling AWS:
• DPO_A_106_Level0
• DPO_A_106_Level1
• DPO_A_106_Level2
• DPO_A_106_Level3
• DPO_B_106_Level0
• DPO_B_106_Level1
• DPO_B_106_Level2
• DPO_B_106_Level3
They contain functions with register settings for mode A and B, with distinct parameters for up to four power 
levels.

Figure 22. Analog configuration with DPO modes

When using such an analog config containing AWS settings, the GUI detects them when switching to the DPO 
tab. This automatically sets the number of levels and enables advanced GUI widgets, showing NFC-A and NFC-B 
wave shapes, providing an easy way to fine-tune AWS parameters, as depicted in the following figure.
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Figure 23. DPO CR tab
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The user can access a given set of power level parameters by clicking on the matching power level bar. The set 
of registers and the wave shape background color are updated accordingly.

Figure 24. Choose a power level set of parameters
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The user can either set manually undershoot/overshoot register value both NFC-A and NFC-B, or click on the tick 
boxes. The corresponding register value is updated too.
Once the continuous measure button is pressed, the current AWS parameters are saved to the board, and 
alternatively WUPA and WUPB commands are continuously sent. This feature allows quickly fine-tuning and 
directly seeing the effect with a scope, without going through the different tabs provided by the tool.
New parameters are sent to the firmware when restarting the continuous measure.
The AWS settings are shared with the analog configuration tab. They are updated when switching back to the 
analog configuration tab. The log window shows:

Figure 25. Log confirming export of AWS registers

This allows the user to review them and uses the actions documented in the Analog Config tab chapter . For 
example: save a file or generate custom code.
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2.2.5.5 Card emulation tab
This tab allows the user to configure the ST25R300 in card emulation. It either emulates a T4T (in case of NFC-
A), or a T3T (in case of NFC-F). Different contents can be configured.

Figure 26. Card emulation tab

Note that some changes to the default values can make this emulation not inter-operable with a phone anymore.
The memory of the card emulated is hosted on the GUI, and depends upon the PC reactivity and speed.
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2.2.5.6 DLMA

Figure 27. DLMA

DLMA (dynamic load modulation amplitude) allows to configure the load modulation amplitude depending on 
perceived field strength. The shown table is used to traverse through the different CEM_RES values.
Measured values a be visualized.
Visualization shows only interesting values if an external reader or mobile phone is presented.
Two different values are shown:
• The value at field on as used by the DLMA algorithm
• A live measurement triggered by GUI timer (accuracy subject to PC load). This value is different from the 

other value if the reader is moving in relation to the STEVAL-25R300 board.

2.3 Debug tab
The Debug tab allows the user to access the STEVAL-25R300KA at lower levels. Specifically, the user can 
explore the different technologies in detail using the NFC-A / ISO 14443A, NFC-B / ISO 14443B, and NFC-V / 
ISO 15693 subtabs. The Low level subtab is not dedicated to a specific technology. It allows the user to control 
the assembled reader chip using chip specific commands as specified in the DS13658 datasheet.
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2.3.1 NFC-A / ISO 14443A tab

Figure 28. NFC-A/ISO 14443A tab

The NFC-A / ISO 14443A tab allows the execution/debugging of the different stages of NFC-A technology in 
accordance with the NFC Forum™/ISO 14443A standard. The GUI highlights the next button to click to assist the 
user. If the button is clicked and the operation is successful, the next suggested button is highlighted in blue. If a 
card is present, successful communication guides the user through the TechnologyDetection and 
CollisionResolution steps. The user then activates the card by clicking HandleActivation. After activation of the 
card, the user sends predefined or custom commands to the card using the Transceive button.

Note: NFC Forum and the NFC Forum logo are trademarks of the Near Field Communication Forum.
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2.3.2 NFC-B / ISO 14443B tab

Figure 29. NFC-B / ISO 14443B tab

The NFC-B / ISO 14443B tab provides functionality to execute/debug the different stages of NFC-B 
communication according to the NFC Forum™/ISO 14443B standard. The GUI assists to the user by highlighting 
a suggestion of the next button to press. The highlighted buttons take the user through the Initialize, 
TechnologyDetection, CollisionResolution, and HandleActivation steps.
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2.3.3 NFC-F/FeliCa tab

Figure 30. NFC-F / FeliCa tab

The NFC-F / FeliCa tab provides functionality to execute/debug the different stages of NFC-F communication 
according to the NFC Forum/FeliCa standard. The GUI assists to the user by highlighting a suggestion of the next 
button to press. The highlighted buttons take the user through the Initialize, TechnologyDetection, and 
CollisionResolution steps.
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2.3.4 NFC-V / ISO 15693 tab

Figure 31. NFC-V / ISO 15693 tab

The NFC-V / ISO 15693 tab provides functionality to execute/debug the different stages of NFC-V communication 
according to NFC Forum™/ISO 15693. It provides help to the user by highlighting buttons to press. The 
highlighted buttons guide the user through the Initialize, CheckPresence, and CollisionResolution steps. After 
that, it is possible to execute ReadSingleBlock(s) to read one block of the card memory.
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2.3.5 Low level tab

Figure 32. Low level tab

The Low level tab allows direct control of the ST25R300 reader mounted on the board. For details, see the 
ST25R300 datasheet (DS14655).
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3 Other dialog boxes and panels

3.1 Register map
In the menu, click View > Register Map to open the register map.

Figure 33. Open the register map

The Register Map window, shown in the figure below, is a view that displays all registers and their values. It also 
allows changes to the register settings.

Figure 34. Register map
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When the Register Map window is open, it displays a list of register names with their addresses on the left side. 
On the right side, it shows the register values in hexadecimal. Between the register names and the register 
values, there are also 8 bits, which represent the current contents of the registers. Click on a bit to toggle the state 
from 1 to 0, or vice versa. This feature is disabled for some read-only registers. When it is the case, the register 
bits are grayed out.

3.2 Updating the firmware
To update the firmware, do one of the following:
• Click the Update Firmware button in the Board Info tab.
• In the top menu, click Help > Firmware Update.
• Press CTRL + F.
The Firmware update dialog box illustrated below allows the flashing of firmware on the MCU of the ST25R300 
evaluation board directly from the ST25R300 Eval GUI. The GUI comes with firmware for the evaluation board. 
The firmware combo box shows all the pieces of firmware located in the firmware folder specified by the firmware 
dir parameter. The latest version of the firmware can be found at st.com. Clicking the Update Firmware (using 
mass storage transfer) button flashes the firmware to the board. If multiple boards are connected, ensure that 
the correct board is selected in the Boards combo box.

Figure 35. Firmware update
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3.3 Logging
The Logging window is at the bottom of the GUI. It can be enabled/disabled in the View menu by selecting 
Show/Hide > Logging. It shows the entire communication between the GUI and the connected reader. Any 
request from the GUI is displayed in gray, while a positive response is displayed in green.

Figure 36. Logging

If the communication fails for any reason, this is indicated by a red font in the Logging window.
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3.4 Help panel
To the right of each tab, there is a help panel that provides basic information about the current tab.

Figure 37. Overview

3.5 Configuration manager

Figure 38. Configuration manager

The config manager allows to load and store complete bundles of analog Configs and DPO CR configuration in 
files and also in firmware - either RAM or with "Make persistent" also into an STM32 flash page.
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Revision history

Table 1. Document revision history

Date Version Changes

24-Jun-2025 1 Initial release.
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IMPORTANT NOTICE – READ CAREFULLY

STMicroelectronics NV and its subsidiaries (“ST”) reserve the right to make changes, corrections, enhancements, modifications, and improvements to ST 
products and/or to this document at any time without notice. Purchasers should obtain the latest relevant information on ST products before placing orders. ST 
products are sold pursuant to ST’s terms and conditions of sale in place at the time of order acknowledgment.

Purchasers are solely responsible for the choice, selection, and use of ST products and ST assumes no liability for application assistance or the design of 
purchasers’ products.

No license, express or implied, to any intellectual property right is granted by ST herein.

Resale of ST products with provisions different from the information set forth herein shall void any warranty granted by ST for such product.

ST and the ST logo are trademarks of ST. For additional information about ST trademarks, refer to www.st.com/trademarks. All other product or service names 
are the property of their respective owners.

Information in this document supersedes and replaces information previously supplied in any prior versions of this document.

© 2025 STMicroelectronics – All rights reserved
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